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Introduction 
Purpose of this Manual

Thank you for purchasing the AutomationDirect Productivity®1000 Programmable 
Controller (CPU) family of products.  This hardware user manual provides information that 
will help you install, set up, program, troubleshoot, and maintain your Productivity1000 
CPU system.  The manual includes information that is critical to the safety of the personnel 
who will install and use the controller and to the machinery, processes, and equipment 
controlled by the CPU.
The manual also includes important information about power and signal wiring, mounting 
of the CPU, and configuring the CPU system.

About Getting Started
If you are familiar with Programmable Controllers in general, then following the simple 
steps in this first chapter may be all you require to start being productive using a 
Productivity1000 CPU system.  After you have completed the steps, your Productivity1000 
controller will be running the ladder logic project that you programmed. 

Online Help Files and Other Documentation
The Productivity1000 programming software, Productivity Suite, is available as a 
download from our website. 
See http://www.automationdirect.com/products/pseries.html.
The Productivity Suite software includes searchable online help topics covering all aspects 
of the software, instruction set, module setup, and communications. 
In addition, each power supply, CPU, and I/O module includes an installation insert.

Technical Support
We strive to make our manuals the best in the industry.  We rely on your feedback to let 
us know if we are reaching our goal.  If you cannot find the solution to your particular 
application, or if for any reason you need technical assistance, please call us at:
    1–770–844–4200
Our technical support group will work with you to answer your questions.  They are 
available Monday through Friday from 9:00 A.M. to 6:00 P.M. Eastern Time.  We also 
encourage you to visit our web site where you can find information about our company 
and specific technical information about a wide array of our products.
   http://www.automationdirect.com

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
http://www.automationdirect.com/products/pseries.html
http://www.automationdirect.com
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Conventions Used

NOTE: When you see the “note pad” icon in the left-hand margin, the paragraph to its immediate 
right will be a special note.  Notes represent information that may make your work quicker or 
more efficient.  The word NOTE in boldface will mark the beginning of the text.

WARNING:  When you see the “exclamation point” icon in the left-hand margin, the 
paragraph to its immediate right will be a warning.  This information could prevent injury, 
loss of property, or even death in extreme cases.  Any warning in this manual should be 
regarded as critical information that should be read in its entirety. The word WARNING in 
boldface will mark the beginning of the text.

Key Topics for Each Chapter
The beginning of each chapter will list 
the key topics that can be found in that 
chapter.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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Before you begin...
It is recommended that the following items be available to make this short step-by-step 
introduction to the Productivity1000 System go smoothly.

P1 CPU Module

Screwdriver 
TW-SD-MSL-1

USB-A to Micro USB-B 
Programming Cable 

PC Running 
Windows OS

Hookup Wire
AC Power Cord

P1 Series Power 
Supply

Productivity®1000 System Example

Wire Strippers 
DN-WS

Not available from 
Automationdirect.com

Output Modules
Analog Input Modules P1-08TRS Output Module

Download software from our website 
at: www.automationdirect.com under 
“Programmable Controllers”.

Not available from 
Automationdirect.com.

Productivity Suite 
Programming Software 
PS-PGMSW

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
https://www.automationdirect.com/support/software-downloads#main-content>
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Productivity Suite System Requirements

Productivity Suite, a Windows-based programming software, is available as a FREE 
download at https://www.automationdirect.com/support/software-downloads#main-
content  Please check our website for this product’s current operating system requirements. 

NOTE: USB or Ethernet cable is also required for communications between PC and CPU.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
https://www.automationdirect.com/support/software-downloads#main-content
https://www.automationdirect.com/support/software-downloads#main-content
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Step 1: Install Programming Software

1.  Download the latest version of the Productivity Suite Programming 
Software from the Automationdirect website, or insert the Productivity 
Suite Programming Software USB thumb drive into your PC USB port.

2. By default Productivity Suite will be saved in the “Download” folder as a “.zip” file. 
• Right Click on the ProSuite_xxx.zip file in the Download folder. 
• Choose “Extract All” from the drop-down menu. A popup box will open. 
• Select the “Browse” button and navigate to the folder where you prefer to store the 

program.  
• Click on “Select Folder” button and in the next box choose “Extract”.

NOTE: See the Productivity Suite Installation and Productivity Suite Startup topics for additional 
details if needed.

3. Navigate to the choosen folder and double click on the ProSuite “.exe” file. 

4. The “Setup Wizard” window (shown below) will appear.  Select Next. 

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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5. Carefully read the software license agreement.  If you agree to the 
terms and conditions of this agreement, select the “I accept the 
terms of the License Agreement” and then the “Next” button. 

6.   The “Destination Folder” window will open next. The default loaction will 
appear in the text box: C:\Program Files\AutomationDirect\Productivity 
Suite <Software Version>.  Should you desire a different folder choose: 
a. Browse: This option allows you to select another folder for installation. 

If the installer detects a previous version of Productivity Suite on your PC, there is 
another option available with this window:

b. Replace Existing Instance:  This option allows you to uninstall 
the previous version of the software and install the new version 
in its place.  If you check this option, select the version in the 
window that you want to delete.  Click “Next” to continue.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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7.   Once you have selected the install folder or after deleting any 
previous instances, click “Install” to begin the installation.

A status window will appear displaying the status of the installation.  

A shortcut icon will automatically be placed on the Desktop during installation. 

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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8.   The next screen to appear contains the Release Notes for this version of the 
Productivity Suite software.  This is an opportunity to review the software version 
release notes.  You may read these before selecting the “Next” button.

9.   The Installation is now complete.  Select “Done”.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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Step 2: Launch Programming Software
After installing the Productivity Suite Programming Software, PS-PGMSW, launch the 
software by double clicking the desktop Productivity Suite Icon.  Or from the PC’s ‘Start’ 
menu, select Productivity Suite x.x.x.x.

The Productivity Suite Programming Software will start up and display the Main Window 
as shown here.

NOTE: The recommended minimum screen size for the Productivity Suite Software is 1920 X 1080 
pixels. 

Click on the ‘Start a New Project’ in the Start Productivity dialog box to open a 
programming window.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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The Programming Window is divided into menus and toolbars that work together to make 
project development as simple as possible.

Online Help
It is essential that you use the Productivity Suite online Help to familiarize yourself with the 
software.  Keep it open on your desktop and refer to it frequently as you build your system. 
Click on the toolbar Help button to open the Help file.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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Step 3: Install Hardware
The Productivity®1000 CPU system components snap together to form a configured CPU 
in minutes.  See Chapter 5, Installation and Wiring, for more detailed hardware installation 
information.  What follows are the basic steps:

1.   Connect power supply to CPU (after removing the optional power connector).

NOTE: Optional Power Connector must be removed before connecting a Productivity1000 Power 
Supply.  This precludes connection of two separate power supplies.  

2. OR use an appropriately fused alternate power source, connectting 
directly to CPU Optional Power Connector terminals.

G
0V

24VDC

G     
0V

24VDC

Use ADC 
Part # S5062-R

G
0V

24VDC

G     
0V

24VDC

Optional Power Connector must be Removed
before P1-01AC Power Supply may be installed

Remove Optional 
Power Connector

Align Power Supply
Connector and pilot 
pins slide onto 
P1 CPU module.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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3.  Install I/O Modules and engage locking tabs.

WARNING: Explosion hazard – Do not connect, 
disconnect modules or operate switches while circuit 
is live. Productivity®1000 System does not support 
Hot Swapping!

Step One:
With latch in “locked” position, 
align connectors on the side 
of each module and stack by 
pressing together.  An audible 
click indicates lock is engaged.

Step Two:
To unstack modules, pull locking 
latch up into the unlocked 
position and then pull modules 
apart.

Module InstallationModule Installation

WARNING: Do not add or remove modules with 
field power applied.

Step One: With latch 
in “locked” position, align 
connectors on the side of 
each module and stack 
by pressing together. 
Click indicates lock is 
engaged.

Step Three: To unstack modules, pull 
locking latch up into the unlocked position 
and then pull modules apart.

Step Two: Attach field wiring using 
the removable terminal block or ZIPLink 
wiring system.

LLOO
CC

KK

UU
NN

LLOO
CC

KK

WIRE STRIP
LENGTH

MIN
MAX

P1-08TD1

secure after modules 
are connected.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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4.  Connect appropriate wiring to the power supply (P1-01AC) and I/O (P1-08TRS 
module) in  
this example.

P1-01AC

The power supply and load 
are connected through a 
DC or AC current source.

Power HookupPower Hookup

Grounding
A good common ground reference (earth ground) is essential for proper operation of 
the Productivity1000 system. One side of all control circuits, power circuits and the 
ground lead must be properly connected to earth ground by either installing a ground 
rod in close proximity to the enclosure or by connecting to the incoming power system 
ground. There must be a single-point ground (i.e. copper bus bar) for all devices in the 
enclosure that require an earth ground.

P1-01AC

AC (L)

AC (N)

G

LG

100-240V      48V A
50-60Hz

125VDC, 20W

DC (+V)

DC (-V)

®

DC (+V)

DC (-V)

GND
LOGIC
GND

AC (L)

AC (N)

GND

LOGIC
GND

125VDC 100–240 VAC

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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5.   Connect USB cable.  Use a Micro USB cable with a Type A 
and Micro Type B connectors as shown below. 

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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Step 4: Apply Power to CPU
Ensure proper wiring and the correct voltage is available before connecting wiring to the 
power supply.  Once this is verified, connect power to the power supply.  Once power is 
applied, the CPU will perform a self evaluation and verification.  See Chapters 2 and 5 of 
this manual for more power supply and I/O wiring information.

Step 5: Establish PC to CPU Communications
Select “Choose CPU” icon on the CPU Toolbar and the dialog box shown below will appear.

Highlight the installed CPU listed in the dialog box and select “Connect”. 
When initially going Online with the CPU, a pop-up window will notify you of a project. 
difference between the CPU and the PC.  Select “No, Use PC Project” command button.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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Step 6: Open/Read Hardware Configuration
Before we create a project we must configure the hardware so we’ll have default input 
and output tags for use in our project.  With the CPU in “STOP” Mode, select Hardware 
Configuration under Application Tools  and the following screen opens.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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The Module Configuration screen shows the user tag names for all eight I/O points. 
 Select “OK”.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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Step 7: Create a Project
We will start a new project by entering a simple ladder logic program in the order that 
follows.
Rung #1
Select the “END” position on Rung #1 with your cursor.  From the Instruction List on the 
right, scroll down to Counters/Timers section and double click on the Simple Timer (STMR) 
instruction.  The “Simple Timer” instruction is automatically placed on the selected rung 
and the Simple Timer (STMR) dialog box pops up.

1.  Enter ‘T1_SP’ into the Preset Value field. 

2.  Enter ‘T1_CURVAL’ into the Current Value field.

3.  Enter ‘T1_DN’ into the Done field. 

4.  Select “OK”.  
The Define Tags dialog box opens. 

5.  Enter preset time value of 300 (ms) into “Initial Value” field for Tag T1_SP.  Select OK.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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Place the cursor on the first position on Rung #1 as shown below.  In the Instruction List 
on the right, scroll up to Contacts section and double click on “NO Contact (NO)”.  A NO 
Contact (NO) is placed at this rung position and a dialog box pops up. 

1.  Enter ‘T1_Start’ into the text box.

2.  Select OK.

• The Define Tags dialog box opens.  Select “OK”.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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With the cursor on Rung #1, to the right of contact ‘T1_Start’, we are going to begin 
drawing a branch circuit.  Under the Edit drop down menu, select “Wire”, then select 
“Down”.  Notice that a wire has been added.

NOTE: There is also a wire Erase With Cursor tool in the Edit drop down menu that is used to erase 
any lines that were created using the Wire tools.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html


Chapter 1: Getting Started

1-22 Hardware User Manual, 2nd Ed. Rev. J

Next we’ll draw a wire to the left.  Under the Edit drop down menu, select “Wire”, then select 
“Left”.

Next we’ll add another normally-open contact.  Place the box cursor on the first position on 
the newly created SubRung #1.  From the Instruction list, click & drag a Contact (NO) into 
this box.  A NO Contact (NO) dialog box pops up. 

1.  Enter ‘T1_Manual’ into the field.
2.  Select “OK”.

The Define Tags dialog box opens. Select “OK”.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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Rung #2
Next we’ll add another normally-open contact at the start of Rung #2.  Click & drag a “NO 
Contact (NO)” into this box.  A NO Contact (NO) dialog box pops up. 

1.  In the empty tag field press the down arrow on the right to 
open a drop-down list; scroll down and select ‘T1_DN’.

2.  Select “OK”.

Next we’ll add an Out coil at the end of the rung.  Place the cursor at the end of the rung.   
From the Instructions list Coil section, double click on an “Out Coil (OUT)”.  An Out Coil 
(OUT) is placed on the rung and a dialog box pops up.

1.  In the tag field press the down arrow on the right to open a 
drop-down list; scroll down and select ‘DO-0.1.2.1’.

2.  Select OK.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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The ladder program now looks like this.  When either of the T1 contacts are energized, the 
timer starts.  When it times out, contact T1_DN energizes and turns on the rung 2 output.

Step 8: Save Project
Save the project by opening the File drop-down menu and selecting Save Project.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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Step 9: Write Project to CPU
Next we will transfer the project to the CPU.  Transfer Project is accessed by selecting 
Transfer Project from the File Menu.  
Select “To CPU” from the Transfer Project menu. 

The project will then be Transferred to the CPU from the PC.  During the transfer a status 
window will open displaying the process.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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Step 10: Place CPU in RUN Mode
Next, verify the Run/Stop switch on the CPU faceplate is placed in the Run position and 
then place the CPU in RUN mode on the Productivity Software Toolbar so the ladder logic 
program executes.

NOTE:  If the Run/Stop switch on the CPU is in the Stop position, the Run button on the 
Programming Software Toolbar will be disabled. 

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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Step 11: Test the Project Using Monitor Mode
In this next step, use the Monitor Mode and Data View to test the ladder logic program.  
Select Monitor Mode from the top of the Ladder Logic screen to display the status of 
Boolean and Integer Tags.

Using Data View, the Tag values can be viewed or manipulated for testing the project.  The 
Data View window can be accessed by selecting Data View from the Tools Menu of the 
Main Menu.
For the Simple Timer Instruction, a Monitor button is provided that, when selected, will 
load the tags associated with the instruction into Data View. 

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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The tags will be placed in a separate Tab titled New Task - STMR as seen below. 

The remaining tagnames in the Ladder Logic can be added to the Data View window by 
clicking on a blank area in the Tagname column.  This will display a drop down menu where 
the tags can be selected.  Scroll down the list and select the tags to be added.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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Once all of the tagnames have been added, they can now be monitored and manipulated.  
See the Data View help file topic for additional details if needed.

NOTE: Force must be enabled for a Tag in the Tag Database before Force can be used in Data 
View.

http://cdn.automationdirect.com/static/manuals/p1userm/p1userm.html
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